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Introduction to the ITU HEBC
software package

* General principles:

* Consistent with Article 12 and Resolution 535 of
WRC-97.

Developed in consultation with administrations,
broadcasters, and coordination groups.

" Takes into account the availability of suitable
computer hardware by administrations to run the
software.




Key features of the software

modules

- Eﬂrﬂ - Data Capture software
a@j - Calculation software
an

*p" - Data validation software

B - Antenna calculation software




HFBC REQ
Data capture software

* Capture HF requirements.
* Create and modify requirement files.




HFBC REQ

7| ITU/RR1 2 submission - M:\BRTSDABCDAHFBC\B101\81051ReadyForPublication\B10T2-15918-CZE.txt - HFBCREQ

File Display Tools Preferences Help Frangais Espariol

Seazon B10

Enter/Change data as required.

Source

Frea/Band Start time

Stop time

Start [ ate

Stop Diate

Davs Operation

Alt Freg 1

Ma of requirements F3hh

’T
’?

‘22‘30

All requirements Site name

|23‘uu

‘ 1043172010 ‘ 372772011

Target Cirafs

1234567

At Freq 2

Click below to select requirement ‘

5930 0700-0800 []
5930 1600-1630

Antenna designation

‘3?,33,45,4?

Prar s tax Azm tdod

Slew

Design Freg

At Freg 2

5930 1700-1730
5930 1730-1800
5930 1800-1830
5530 1900-2000
5930 2000-2100

‘ 100 ‘ 0 ‘ 199

Remarks

5930 2100-2130
5930 2130-2230
5930 2300-2400
5980 0500-0530
5995 1830-1900
6055 1230-1300
6055 1300-1400
1630-1700
[

Drelete requirement

Clear all fields

0800-0830

1100-1130
2 00—
0100-0300
15301600
5 0430-0500
1130-1230

1000-1100




ITU HFBC
Calculation software

* The main HF module, linked with the data
capture module.

* Propagation prediction: calculates propagation
data; results in tabular form or on maps.

* Compatibly analysis: calculates interference
from other requirements; identifies interference
sources; results are shown on maps.




ITU HFBC

GO TO COMPATIBILITY ANALYSIS MODE - B1051 on ITU HFBC CD-ROM - ITU HFBC 5.2

Schedule  Tools Preferences Help  Frangais  Espariol

Mowve cursor on test points and Left-Click to display results. Right-Click with cursor elsewhere to show Menu

Field strength in dBu¥/m for Hour 22

80

FS dBu¥im

Hour 22

>90

[20,59]
[F0.79]
[60,69]

[50,59]

[40,49]

[30,39]

[20,29]

[10,19]

<10

EEE | | | H0HH

+-10kHz

[ ~E TCH LIT 47
[B8) 7355 D 2200-0400 USA FCC RNO 3-5.3-11.17 27

[1179] 7360 D 2155-2400 CHN RTC Bl 425E 435%/

[2838) 7360 D 1200-2400 ELR SDT MKNS 27,28

[3437] 7350 D 2200-2300 RUS GFC NY'S 43.44




HFBC VAL
Data validation software

* Designed to assist administrations to validate
quickly their HFBC requirement files:

* For Article 12 HF bands.
" For Regional coordination groups bands.

* Remove requirements with frequencies out of
the Article 12 bands.




HFBC VAL

- HFBC VAL 2.0 - M:ABRTSDABCDAHFBC\B10Y31051ReadyForPublication\B10T2-1591 8-CZE. txt
File Edt vValidate Tools Help Frangais Espafiol

4 error(s); Total number of requirements = 26

; B10 CZE 30-AUG-2010 TCH

t —-t--—t+---+ t
LOC POWE AZINUTH 3LW ANT DATS ADN BRC FMO REQ# OLD ALT1 ALTZ ALT3 NOTES
t —-t--—t+---+ t

LIT 100 260 0 101 1234567 311010 270311
LIT 100 260 101 1234567 5311010 270311
206 1234567 311010 270311
206 1234567 311010 270311
206 1234567 311010 270311
594 1234567 311010 270311
894 1234567 311010 270311
1234567 311010 270311

94 1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311
1234567 311010 270311

Fraleu RPR TCH &0&6
Deu RPR TCH 85057
Eng RPR TCH G089
Fra RPR TCH 85020
Eng RPR TCH 5051
Spafra RPR TCH 85024
Spaces RPR TCH 85053
Eng RPR TCH 6346
Spaces RPR TCH 14123
FraEng RPR TCH G054
Rus RPR TCH 8505968
Rus RPR TCH 12238
Rus RPR TCH 5087
Deuces RPR TCH 6351
Ces RPR TCH 141ZZ
Jpa RPR TCH 15132
CesEng RPR TCH 15131
Eng RPR TCH 6360
Deu RPR TCH 6358
Eng RPR TCH 6352
Eng3paCes CZIE RPR TCH 14074
Rus RPR TCH 14143
Jpaces CZE RPR TCH 8085
Eng CZE RPR TCH 6369
Engles CZE RPR TCH 8101
Engles CZE RPR TCH 63587

27,28,36,37
27,28,36,37
27,28

13, 14,37
3-10

25-30

28-31

28-31
18,27,28
35-40

1z-16

7-10

27

27-29
37,38, 46,47
7-10

29-32

12-16
38,39, 45
18,28

37,46
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HFBC ANT
Antenna calculation program

Theoretical approach based on
Recommendation ITU-R BS.705

Calculates the radiation patterns and gain of the
most common used HF antennas.

Provide quick reference for administrations and
broadcasters in identifying antennas.




Englizh Antenna Code Antenna Type Horizontal log

E=pariol
Antenna designation

Frangaiz

HFBC Antennas

Ground dielectric constant (3 - 80) Shortest to longest element distance (m)

Ground conductivity (00003 - 5.0 Sfm) Height of the shortest element (r)
Fleaze enter Artenna Code or select

from list below Operating frequency (2 - 30 MHz)
If required, make changes to
parameters and click Refresh

Height of the longest element (m)
Murnber of elements (20 max) Feeder impedance (999 ohm max)

Half-length of the shortest element (m)

Half-length of the longest elernent (m)

Ante T
fenna Type Azimuth at Gain max (degrees) Directivity Gain {dBi) 1.8
AHR (100-29 Elevation at Gain max (degrees) 14 Flaor/Step value (dB) -30/3
CHR (300-499) ) ) ) )
Horizontal pattern at 14" elevation Vertical pattern at 0° azimuth

EHR (B00-609)

CH (FO0-750)

CT (FBO-783)

LPH (300-849)
LPY (850-874) 5
RH (875-924) s
HQ (925-049)
HX (950-074)
Wih (975-990)

Old Cades (1-75)

Tools

Refresh

Print

Exit




Thank you for your attention

Questions
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HFBC Exercises

ITU Regional Radiocommunication Seminar for Asia-Pacific
2013 (RRS-13 Asia-Pacific)

o o -~ HFBC EILEHEDULE ADGF - 11/2006
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Exercise 1 — @ HFBC REQ 1.3 - Data Capture

Purpose and objectives:

A simple requirement file for notification to the ITU has to be created and saved using the Data Capture
software HFBC REQ 1.3.

Input data:

e Requirement file should cover the season B12 (October 2012 — March 2013)
o Administration responsible: Malaysia
e Onerequirement to be included in the requirement file:
o Freguency: 5965 [MHZ]
Transmission time slot: 00:00-24:00 [UTC]
Sart Time: code: 00 00
Sop time: code: 24 00
Coverage aria: Malaysia, Indonesia, 54 [ CIRAF zones]
Transmitter site location: Kajang, code: KAJ
Transmitting power: 100 [KW]
Azimuth of the maximum radiation: O [ Degrees]
Antenna slew angle: 0 [Degrees]
Antenna type: Quadrant antenna HQ1/0.5, antenna code: 926
Days of operation: From Monday to Friday, code: 1234567
Period of operation: From 28-Oct-2012 to 31-Mar-2013
Sart Date: 28/10/2012
Sop date: 31/03/2013
Modulation: Double-side, code: D
Language used for the transmission: Malay, language code: May
Broadcaster: Radio Television Malaysia, code: RTM
Freguency manager organization: Radio Television Malaysia, code: RTM
Alternative frequency: None
Data type: new requirement, code N

O O0O0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0ODOOOOoOOoODO



Solution - Stepsto be followed:
1. Run the HFBC REQ 1.3 software.

2. Configure the “Open” dialog box:
“Requirement fileto ITU”; Open anew requirement file, “B12 season”.

3. Configure the “ Authorised Notifying Organisations’ dialog box.
“MLA, Malaysia’.

* 11U W11 2 submission - pew - HEBCRL]

Fin Depley Tools Prefeesnces Ml Froncas Espafiol

. T c
Snamon | B2 Enfer/Change dato a3 required.

Souce ’—um

Ermffan Stoe b St Sl Dk Shinls R Ot A Fioad
N of requmrements | 0 [ I | | w [ o0 [' 2 | o [ 1072002002 [ 73172003 12567 |
Al eyl rements Sie Stw e Targes Conls diFing d
ok bt e 1 sl recqurement | | |
ol Coxle Arberna deagnaton P bt Shew M iz {T=) Desgn Fing Al d
o [
| | | | |
[ bt B MO Lorsuae Remahs Dot pe
| | MLA | I (]
Bave charges ‘ Add 2 & NEW roqusment ‘ Dishein sequiement ‘ o ol ok ‘

E_-‘_
=————— —

4. Typein or select from the item titles the appropriate input data for the requirement.

5. Check datain the input part of the screen. It should be:

Frea/Band Start time Stop time Start Date Stop Date Days Operstion At Freg 1
‘ 5965 [T] ‘ [iTi] ‘ 24 ‘ [iTi] ‘ 10/26/2012 ‘ W32M3 1234567 ‘
Site Site name Target Cirals At Freg 2
‘ KAl ‘ ‘54 ‘
Ant Cade Antenna designation Puar Evwf Slew Max Az Mad Design Freq Al Freq 3
‘ 926 ‘ ‘ 100 ‘ 1] ‘ 1] ‘ D ‘ ‘
Adrn Mt Brc FMO Languag Femarks Data type

‘MLA ‘MLA

RTH ‘ RTM| ‘ ‘ ‘ N

Save changes ‘ Add az a NEW requirement ‘ Delete requirement ‘ Clear all fields ‘
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6. The graphical part of the screen should display the antenna diagram of the selected antenna system and the
reguested target service area:

“*L 74

7. To save the requirement, click on “Add as a NEW requirement” button, then OK.

8. Please note that this first added requirement appearsin left blank box which contains a short list of all
requirements included in the notification file.

* 11U 18t 2 subsmission - new - HEBCREQ
Fin Depley Tools Prefeesnces Ml Froncas Espafiol

N of requrements [ 1 5965 [0 | [ | 2 | 0o | 1072002002 ; 73172003 T 12567

e e Tasyet Cands AhFisad




9. From the main “File” menu, select “ Save’. A dialog box appears requesting you to select the code of the
organization authorized to submit requirements on behalf of your administration. Select the code MLA.

10. Select afolder on your computer to save the file. Please note that automatically, the proposed name of
your requirement fileisset to: [Season][Notifying organization].txt (B12MLA.txt)

11. Your fileis saved as a ssimple text file format and ready to be sent to the Bureau.

12. Close the application.
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Exercise 2 — 5 HFBC VAL 2.0 - Data validation

Purpose and objectives:

Open an old submitted requirement file (from previous season). Validate it for season B12 using the Data
Validation software HFBC VAL 2.0 and correct it. Save the file under the name of B12MLIfromB11.txt

Input data:
e Existing requirement file: B11-MLI.txt
Solution - Stepsto be followed:
1. Execute the HFBC VAL 2.0 software.
2. Select from the main “File” menu “Open”, and then locate the B11-MLI.txt file.
3. From the main “Validate” menu, select “B12” for season B12.

& HFBC VAL 2.0 - M:\BRTSD\BCD\HFBC\docs\Seminarsi2012\811-MLI. txt

File Edi vaiidate Tools Help Frangais Espafiol

61 error(s): Total number of requirements = 30

} E11 MLT 19-JUL-2011

; pour novification & 1'UIT
; Mo totale des besoins 30

; & 1'exception de la premiére ligne [contenant saison. org notificatrice, date)
; Lignes commengant avec virgule (;) sont ignorées par le programme

; crée par HFECREQ 1.3 on 19/07/2011 12:16:45

;FREQ DEBU FIN  ZONES CIRAF LOC PUIS AZIMUTE PIV ANT JOURS  DDATE FDATE MOD AFRQ LANGUE ADM RDF ORG REQ# VIE ALT1 ALTZ ALT3 NOTES

5995 0600 0800 46 BEC 100 0O 0 925 1234567 301011 250312 D 5995 NLI MTR 1 b} MLI
59595 1800 2400 46 BEO 100 O 1] 925 1234567 301011 250312 D MLI MTR 2z i} HLI
7285 0800 0300 46 BEOQ 100 0O 1] 925 1234567 301011 250312 D 7285 MLI CRI 3 i MLT
7295 2300 0000 46 BEC 100 0O 0 925 1234867 301011 250312 D 7295 MLI CRI 4 N MLI
9635 0800 1800 46 BEO 100 45 o 216 1234567 301011 250312 D 9635 MLI MTR 5 n HLI
11640 1800 1830 46E, 477 BEOQ 100 0O 1] 206 1234567 301011 250312 D 11640 MLI CRI [ i MLT
11640 1830 1930 47E, 45NU BEOC 100 85 o 206 1234567 301011 250312 D 11840 MLI CRI 7 i} HLI
11640 1930 2000 525, 53W BEO 100 111 o 216 1234567 301011 250312 D 11640 MLI CRI g n HLI
11640 2000 2100 485U, 52NE, 53 BEC 100 111 0 216 1234567 301011 250312 D 11640 MLI CRI E) ol MLI
11640 2100 2130 4830, SZHNE, 53 BEO 100 111 o 216 1234567 301011 250312 D 11640 MLI CRI i b} HLI
11975 2130 2230 446 BEO 100 20 1] 216 1234567 301011 250312 D 11640 MLI CRI 11 ij MLT
11975 2230 2300 37,38W BEOC 100 20 o 216 1234567 301011 250312 D 11840 MLI CRI 12 i} HLI
11975 2300 0000 37,38W BEOQ 100 20 o 216 1234567 301011 250312 D 11640 MLI CRI 13 n HLI
13630 1930 2000 52,53 BEC 100 111 0 206 1234567 301011 250312 D 13630 MLI CRI 14 N MLI
13630 2000 2100 45,53 BERO 100 111 o z06 1234567 301011 250312 D 13630 MLI CRI is n HLI
13630 2130 2230 46,47,52 BEO 100 111 1] 216 1234567 301011 250312 D 13630 MLI CRI 16 ij MLT
13630 2100 2130 48,53 BEO 100 111 1] 206 1234567 301011 250312 D 13630 MLI CRI i7 i} HLI
13645 1700 1800 4851, S3HW BEO 100 111 1] 206 1234567 301011 250312 D 13645 MLI CRI 18 i MLT
13645 1800 1830 46 BEC 100 111 0 206 1234567 301011 250312 D 13645 MLI CRI 19 N MLI
13685 1300 1400 46 BEO 100 111 o 206 1234567 301011 250312 D 13685 MLI CRI 20 n HLI
13685 1400 1500 52N, 53 BEC 100 111 0 206 1234567 301011 250312 D 13685 MLI CRI 21 M MLI
13685 1500 1600 SZM, 53 BEO 100 111 1] 206 1234567 301011 250312 D 13685 MLI CRI 22 i} HLI
13685 1830 1830 37,38 BEOQ 100 20 1] 216 1234567 301011 250312 D 13685 MLI CRI 23 i MLT
15125 1600 1700 47E, 48NT BEC 100 85 0 206 1234567 301011 250312 D 15125 MLI CRI 24 N MLI
15125 1700 1800 4835, S3NW BEO 100 111 o 216 1234567 301011 250312 D 15125 MLI CRI 25 n HLI
15505 2230 2300 46,48 BEC 100 85 0 206 1234567 301011 250312 D 15505 MLI CRI 26 M MLI
17630 1400 1500 46,48 BEOQ 100 85 o 206 1234567 301011 250312 D 17630 MLI CRI 27 b} HLI
17630 1500 1600 46,45 BEOQ 100 85 1] 206 1234567 301011 250312 D 17630 MLI CRI 28 i MLT
17880 1300 1400 46,47,52 BEOC 100 111 0 216 1234567 301011 250312 D 17880 MLI CRI 29 N MLI
17880 1600 1700 37,38 BEOQ 100 20 o 216 1234567 301011 250312 D 17880 MLI CRI 30 n HLI

Note that errors detected by the software appear in red.

4. Changethe“FDATE” and “TDATE” fields to the date of season B12.
From the main “Tools" menu select “ Change the Start/Stop dates to...” B12.
Indicate “Y” in Old Data column.
Select “Validate” for B12 season.

No errors!



Edit.

Validate Tools Help Francais Espafiol

E12 MLI 13-Hov-2012
enerated from previous submitted requiremenc file B11-MLI.txt

; pour notification o I 0T
: Mo totale des besoins 30

; & l'exception de la premiére ligne

(contenant saison. org notificatrice, date)
; Lignes commengant avec virgule [;] sont ignorées par le programme
; crée par HFBCREQ 1.3 on 19/07/2011 12:16:45
;FREQ DEBU FIN  ZOMES CIRAF LOC PUIS AZIMUTE PIV ANT JOURS DDATE FDATE NOD AFRQ LANGUE ADM RDF ORG REQ# VIE ALT1 ALT2 ALT3 NOTES
5995 0600 0800 46 EKO 100 0 o] 925 1234567 251012 310313 D 5995 MLI NTR 1 ¥
5995 1800 2400 46 BKO 100 O 0 925 1234567 281012 310313 D HLI HTR 2 ¥
7295 0800 0900 46 BKO 100 O 0 925 1234567 281012 310313 D 7295 HLI CRI 3 ¥
7285 2300 0000 46 BKO 100 0 0 925 1234567 251012 310313 D 7285 HLI CRI 4 k4

5. SavethefileasB12ML [ fromB11.txt

6. Close the application.

HLI
MLI
MLI
MLI
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Exercise 3 — g ITU HFBC 5.2 — Propagation and compatibility
analysis

Purpose and objectives:

Analyze the Basic Service Reliability (BSR) and Time Service Circuit (T SC) for specific group of
requirements published in ITU HFBC schedule (in thelist view mode).

Input date:

e (CD-ROM) HFBC Schedule B12S1.

Solution - Stepsto be followed:
1. Execute ITUHFBC 5.2 software.

2. Open schedule: B12S1

3. Select “List view”

" |GO TO COMPATIBILITY ANALYSIS MODE - B1251 on ITU HFBC CD-ROM - ITU HFBC 5.2

Schedule RUERE Preferences Help  Francais  Espafiol

Display requirements from  »

Move - Click to display requirements. Right-Click

B1251 (4006 requirements)

80

4. Thelist view is displayed:

GO TO COMPATIBILITY ANALYSIS MODE - B1251 on ITU HFBC CD-ROM - ITU HFBC 5.2

Schedule  View Preferences Help Frangais  Espafiol

Click on item display detailed information. Click +/- to expand/contract nodes. Right-Click to show Menu.

B1251 {4006 requirements)

AFS(85)
ALB(41)
ALG(8)

ARH(3)

ARS(80)
AUT(25)
B (76)
BFA(2)

BLR(14)
BOL(24)
BOT(27)
BUL(23)
CAN(64)
CHL(25)
CHN({931)
CLH(60)
CUB(41)




5. Display requirements from an administration:
From “View” menu, select “Display Requirements from”, then select “ Administration: ALG (Algeria)”.

6. Click on the ALG (8) to expand the requirements from Algeria.

Schedule View
Click on item display detailed information. Click +/- to expand/cc

B1251 (4006 requirements)

Administration

AFS(85)
STRT-STOP ADM FHO CIRAF ZONE SIT PUR ATM ANTENNA
0400-0600 ALG TDA 46HU, 37SH ORG 250 206 AHR(S)2-2/0.5
0400-0600 ALG TDA 46NE,47HW, 37SE BEC 250 135 AHR([S)2/2/0.5
0600-0700 ALG TDA 46N, 37SW ORG 250 206 AHR(S)2/2/0.5
0600-0700 ALG TDA 46ME,47HU, 37SE BEC 250 135 AHR({S)2-2/0.5
1800-1900 ALG TDA 46HE.47HW, 37SE BEC 250 135 AHR(S)2-2/0.5
1800-1900 ALG TDA 46N 37SW ORG 250 206 AHR([S)2/2/0.5
1900-2300 ALG TDA 46N, 37SW ORG 250 206 AHR(S)2/2/0.5
1900-2300 ALG TDA 46ME, 47HW, 37SE BEC 250 135 AHR(S)22-0.5

7. Note the some requirements are displayed in red and somein blue.

8. Note the status bar at the bottom:

i INS{51)
eI (77

Requirements in RED have BSR or TSC less than 50% RCG reftables. ¥=2012 Mon=10 55N=T4 S/N=34dB SN=17d8 FR=5kHz

Requirements in RED color have BSR or TSC less than 50%.
Requirements in BLUE color have BSR or TCS more than 50%.
9. Analyze data for the requirements:

BSR and TSC values are presented as numbers from 0 to 9 (from 0% to 90%) for each transmitting hour
(from Hour 4 to Hour 6 or 0400-0600...) and for each seasonal period:

November —beginning of the season;
January —middle of the season;
March —end of the season.

10. Click on aregquirement to display detailed results:




é-----AI:G(H)

(REF) FREQ M STRT-STOP ADM FMO CIRAF ZONE
(2621 7265 D 0400-0600 ALG TDA 46HW, 375W

-9-

SIT PWR AZM ANTENNA
ORG 250 206 AHR(S)2-2-0.5

HO405
73
61
7
HO405 Interfered Cirafs (Vanted Unwanted FS) (EEF) FREQ M STRT-STOF ADM FMO SIT CIRAF ZONES
29
— 3VSW,4eNW(22-41-50-39dBu) (34e6) 7265 D 0400-0430 G RCI WOF 32E, 3950
— K 375Wi{21-18-32-18dBu}) (17e6) 7265 D 0500-1700 D FNA4 GOH 18.19.27,28,.29 378
K 375Wi20-7-20-7dBu) (8133 ¥2e0 D 0257-120% CHN RTC URU 42H
29
H - 375W, 46HW(19-41-48.-37dBu) (34663 7265 D 0400-0430 G RCI WOF 38E, 3957
- K 375Wi{13-21-31-16dBu) (1766} 7265 D 0500-1700 D FHA GOH 18.19.27.28.29 37H
29
H — 375W_ 46HW{30-41-50-390Bu} (34663 F265 D 0400-0430 G RCI WOF 38E. 395W
- K 375W{25-25-40-25dBu} (17663 7265 D 0500-1700 D FHA& GOH 18 19 27 28 29 37H
(2622 7380 D 0400-0600 ALG TDA 46HE. 47NW 375E BEC 250 135 AHR(S)2-2-0.5
(2623) 9490 D 0600-0700 ALG TDA 46HW, 37SW ORG 250 206 AHR(S)2-2-0.5
(2624) 9815 D 0600-0700 ALG TDA 46HE. 47NW, 375E BEC 250 135 AHR(S)2-2-0.5
(2625) 11690 D 1800-1900 ALG TDA 46HE. 47NW, 375E BEC 250 135 AHR(S)2-2-0.5
(2626) 11715 D 1800-19%00 ALG TDA 46HW, 375W ORG 250 206 AHR(S)2-2-0.5
(2627) 11770 D 1900-2300 ALG TDA 46HW, 375W ORG 250 206 AHR(S)2-2-0.5
(2628) 11785 D 1900-2200 ALG TDA 46HE. 47NW, 37SE BEC 250 135 AHR(S)2-2-0.5
IAVH ” 1] H 9
11. From*“View” menu, select “Go to Map view
.GOTO COMPATIBILITY ANALYSIS MODE - B1251 on ITU HFBC CD-ROM - ITU HFBC 5.2 Ny = 2 |
Schedule View Preferences Help Francais Espafiol
Move cursor on Tx site and Right-Click to display requirements. RightClick with curser elsewhere to show Menu
B1251 (4006 requirements)
=] N
os ;/ L 1= 1o | T = R S ) el NP P
+| x|
A} ~
e I = _txpﬁ o/
A N T = : bz
- 2
EC N as |—
2 5 "5' e
o ss wEe
oo
=7 Xi o ss A
| ﬁ
==
Ay e
| e oy

Ta

12. Display al requirements from an administration: ALG (Algeria)
Note that the location of the transmitter sitesis marked on the map.

13. Right click the transmitter site cross BEC and select the requirement REF. (2625) from the list of the

ALG requirements.

B1251 adm="ALG' (8 requirements)
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The antenna pattern of the selected requirement (2625) is displayed on the map in blue. The regquirement
appearsin the list as Wanted. Other “Unwanted” requirements are indicated as potential interferes. Potential
interfering requirements on the same channel are displayed in red, those on the adjusting channels +/- 5 kHz
in yellow, and those in on +/- 10 kHz channelsin green.

Ol Al on ITU HFBC CD-ROM - ITU HFBC 5.2

Schedule Tools Preferences Help Frangais  Espafiol
Move curser on Tx site and Right-Click to display rec

Wanted : (2625) 11690 D 1800-1900 ALG TDA BEC 46NE 4TNW,37 SE and potential interferers (1)

]
i.”

=

i
¢
ir‘_,E
S

)
i

N
'
b qé\
-

)

i)

NG

=
W

7= = IAJM/—BL—MWW'_H:;% o
- Mi&/ E

:1 Hanted 0kEz ~-10kHEz

[Warted:  (2625) 11690 D 1800-1900 ALG TDA BEC 26NE 47NW,37SE
Unwanted: (1675) 11685 D 1700-2000 BUL SPC SOF 28,27

You are at 33.06N - 164 00W RCG ref tables =202 Mon=10 SEN=T: 4|
e = - .

14. From “Tools’ menu, select “Calculate”, then “Run compatibility analysis’.
The software calculates...

15. A chart of the median Field Strength for each hour of operation is displayed:

Median Field strength in dBuV/m for each Hour of Operation
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16. Display the compatibility analysis on the map:
From “Tool”, select “ Show Map”.

[ GO 7O COMPATIBILITY ANALYSIS MODE - 81251 on ITU HFBC CD-ROM - ITU HFBC 5.2 - - T e - b

Schedule Tools Preferences Help Frangais  Espariol

Move cursor on test points and Left-Click to display results. Right-Click with cursor elsewhere to show Menu

Field strength in dBuV/m for Hour 18
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Unwanted:  (1679) 11685 D 1700-2000 BUL SPC SOF 28.27

17. Display the other parameters: Field Strength, Power received, Basic circuit reliability, Signal to
Interference, Overall circuit reliability.

From “Tools’, select “ Select Values’, then:
- “FS’ —Field Strength

- “PWR” — Power received

- "BCR” —Basic circuit reliability

- “Stol” — Signal to Interference

- “OCR” —Overal circuit reliability

18. Switch between the different types values: Minimum, Median, and Maximum of the currently displayed
parameter.

From “Tools” menu, select “ Select Vaues Types’, then “Minimum”/” Median” /" Maximum”.

19. Zoom the map: click inside a continent, in this case, Africa:
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Move cursor on test points and Left-Click to display results. Right-Click with cursor elsewhere to show Menu

Field strength in dBuV/m for Hour 18
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Exercise 4 — HFBC ANT 1.0 — HF transmitting antennas

Purpose and objectives:
Display horizontal and vertical patterns of an antenna.
Input data:

e Curtain antenna, half-wave dipole array, dual band, centre-fed, no reflector. Antennatype:
CH1/1/0.3, antenna code: 700

This software is often used to determine the code, the description, and the parameters of the commonly used
HF transmission antennas.

Solution - Stepsto be followed:
1. Executethe HFBC ANT 1.0 software.
2. Select the type of the antenna:

From the left menu “ Antennatype”, select “ CH (700-750)", then from the list select “700 CH1/1/0.3".

+ \HFBC Antennas

Antenna Code '700 Antenna Type Cuttain antenna, halfwave dipole array, dual band, centre-fed, no
teflector

Antenna designation CHI/1/0.3

pattern at 47° ion Wertical pattern at 0° azimuth

Tools

Refresh

Print

The selected antenna and its characteristics are displayed.

3. Select an antenna by specifying its code:
Type the code in the “ Antenna code box”:
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HFBC Antennas

Antenna Code 701‘ Antenna Type

Antenna designation CHI/1/05

Curtain antenna, halfwave dipole array, dual band, centre-fed, no
reflector

4. Print the antenna parameters:
From the left menu, click on “Print”.

5. Close the application.
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